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1. WARNINGS and SAFETY

To prevent damage to the Submersible Autonomous Moored Instrument (SAMI) or Autonomous
Flow-Thru (AFT), please carefully read the operating instructions before attempting to use your
instrument. The cable provided with both instruments is for bench-top programming and
download of the SAMI/AFT and is NOT submersible!

The SAMI and AFT instruments are reagent-based with the reagent stored in sealed foil bags
underneath the instrument. It is possible, though very unlikely, that these bags may leak or
rupture. In case of exposure to the reagent, please refer to the material safety data sheets in the
appendix of this manual.

After deployment both instruments should have their membranes flushed out, described in more
detail in section 5. (Use the Cycle Pump function on the Utility Tab of SAMI Client to pump
deionized water through the membrane.)

SAMI

The SAMI can be powered externally (10-13VDC). Observe common safety protocols when
using any external power supplies, especially in a wet environment. While the instrument is

diode protected for reverse voltage, large voltages will damage the instrument. Connect with
care!

AFT
The AFT-CO, flow chamber should be flushed with de-ionized water after removal from
seawater to prevent mineral build-up in the plumbing.

1.1 AFT Installation Considerations

The AFT is typically used on a ship or other static location and will be plumbed in. For correct
measurements, some care must be taken installing the instrument. The primary concerns are
minimizing temperature changes and pressure across the unit.

Proof Pressure

The AFT flow chamber is proof tested for leakage to 12 psi. Care must be taken not to exceed
this pressure at any time to avoid leakage into the electronics or the surrounding laboratory
area.

The flow chamber has an o-ring seal. If the user opens the flow chamber, care must be taken to
ensure the o-ring is not damaged or dirtied. It should be cleaned and re-lubricated with barium
grease if the chamber is opened.

Operating Pressure

The AFT uses a small 50 ul solenoid pump that can only work against ~ 1 psi (~70 cm H20
head pressure). It is therefore important not to have the flow chamber pressurized. Additionally,
on pCO2 instruments, pressurization will lead to an offset in the reading.

To minimize pressure within the chamber, a flow rate of 2-4 liters/minute is recommended. Do
not restrict flow out of the unit with valves, check-valves, reduced line-size, or by having the
drain line rise above the unit. It is best to have the unit drain into an open sink or similar.



Flow Rate
The recommended flow rate for the AFT is 2-4 liters/minute. This flow rate is high enough to
minimize temperature change yet low enough to preclude pressurization due to flow.

Temperature change

Because the AFT is using temperature readings as part of each measurement, it is important
that the sample not be warmed or cooled significantly from where the sample is being drawn.
Be aware that pumps and long lines can change the temperature. Since heat exchange is a
function of temperature gradient, the user may want to insulate the inlet line if there is a large
temperature difference between the sample and the laboratory.

Recommended Installation Configurations

Figure A. shows two possible configurations for installing the AFT with other instruments
present. Both configurations are suggestions, and may not be applicable to the user’s actual
infrastructure. These configurations are suggested because they should reduce the
pressurization and temperature effects from having any significant impact.

In the first configuration the AFT is upstream from the pump, with the pump pulling water
through the instrument. This will reduce heating of sample, but care needs to be taken not to
reduce the pressure significantly below ambient and thereby bring CO, out of solution. In
second configuration, the AFT is in parallel with other instruments with flow going to both. This
allows the flow rate of other instruments to be independent of the AFT and reduces chance of
contamination, back pressure and temperature change.

Figure A: Schematic of recommended installation configurations with other instruments present.
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Sample Contamination by AFT

The AFT instrument will inject a small amount of reagent into the sample stream with each
measurement. The AFT-CO, will introduce 50 ul BTB for normal CO, measurements and 1.4 ml
after a blank. Blanks on the CO, are typically run every 3.5 days.

2. SAMI2/AFT QUICK-START GUIDES

The following procedure will guide you through the process of starting and stopping your SAMI
or AFT. A more detailed discussion can be found later in this manual.

2.1 SAMI Deployment Settings

You must customize your launch settings to maximize the effectiveness of your deployment. By
collecting a higher quantity of data points you will more quickly use reagent, battery life, and
memory, which will shorten the longevity of your collection time.

We encourage you to weigh your options to maximize the effectiveness of your deployment
while considering the questions you are trying to answer through your research. Use the table
included below to help you decide upon the appropriate parameters for your deployment.

Measurement Measurement Total reagent Total battery
Interval (min) Cycles/day life (days) life (days) *
15 96 104 566
30 48 208 928
60 24 416 1365

* Battery life does not apply to the AFT, which is externally powered.

2.2 SAMI Launch Procedure

1. Attach communication cable to the instrument, power supply, and computer. Please note
that the cable provided is for bench-top programming and download of the SAMI. It is
NOT submersible!

a. Attach the cable to the 6-pin bulk-head connection on the top of the instrument,
with the dot on the cable lined up with the largest diameter pin on the SAMI.

b. Attach the banana plugs (black is ground, red is positive) to a +13 V DC power
supply.

c. Insert the instrument disk into your optical drive.

d. Attach the USB connector to a USB port on your computer. Windows XP or later
is required for PC’s, and most will automatically find a driver for the USB-Serial
converter. If Windows cannot find it, you can locate a copy on the instrument
disk or at http://www.ftdichip.com/Drivers/VCP.htm

2. Copy all files from the SAMI disk to a folder on your computer. Open SAMI Client folder.
Open Windows or Mac OS X folder. Open the SAMI Client application

3. The first time you run SAMI Client, a preferences window should open allowing you to
select the proper COM port. The correct port will usually be the last one in the list on a
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Windows machine. On a Mac the correct port will be ‘usb serial Fxxxxxx’ where the x’s
represent any alphanumeric character. (See figure 1 below)

If you want the application to automatically connect to the instrument using same port in
the future, check the box in preferences. Dismiss the preferences dialog by clicking
‘OK”

If you didn’t check the box in step 4, click on the Serial Open button on the Control page.
Under the Settings tab, in the SAMI subpanel, choose SAMI/AFT CO2 (A+). Set the
desired start time. You may choose to record battery and temperature prior to start using
the ‘Prestart’ sub-panel. If you have any external instruments they will be programmed
using ‘Device 1, 2 or 3’. (See figure 2 below)

Under the Control tab, click ‘Re-power’ if Deployment Cycle Controls are not active.
Erase any data stored in the memory (download if desired), Launch!

If you wish to watch results, you can observe output via the Utility tab. Under the Utility
tab you can also check SAMI status and monitor results. For more detailed output, click
on the ‘View Live’ button on the Control tab page.

To Exit SAMI Client program, click on the ‘Serial Close’ button and then exit the
program, the SAMI will continue to run.

2.3 AFT Launch Procedure

The following procedure will guide you through the process of starting and stopping your AFT. A
more detailed discussion can be found later in this manual.

1.
2.

i

Insert the AFT disk into your optical drive.

Attach the USB connector to a USB port on your computer. Windows XP or later is
required for PC’s, and most will automatically find a driver for the USB-Serial converter.
If Windows cannot find it, you can locate a copy on the SAMI disk or at
http://www.ftdichip.com/Drivers/VCP.htm

Copy all files from the AFT disk to a folder on your computer. Open SAMI Client folder.
Open Windows or Mac OS X folder and open the SAMI_Client application.

The first time you run SAMI_Client, a preferences window should open allowing you to
select the proper COM port. The correct port will usually be the last one in the list on a
Windows machine. On a Mac the correct port will be ‘usb serial Fxxxxxx’ where the x’s
represent any alphanumeric character.

If you want the application to automatically connect to the SAMI using same port in the
future, check the box in preferences. Dismiss the preferences dialog by clicking ‘OK.’

If you didn’t check the box in step 4, click on the Serial Open button on the Control Tab.
In the Control window, click on ‘Stop’ button.

Click ‘Download’ and choose a filename to download SAMI data, if you wish to save the
data.

Launching the AFT

ok wN -~

Attach communication cable to AFT, power supply, and computer

Establish communication with instrument by the clicking on the ‘Serial Open’ button
Enter the SAMI Launch Settings (under Settings Tab)

Erase any data stored in the memory (download if desired)

Launch!

Exit SAMI Client program, the AFT will continue to run
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2.4 SAMI Stop Procedure

1. Remove SAMI from the water and wipe down the top of instrument with a dry rag.
2. Attach communication cable to SAMI, power supply (12 VDC), and computer.

3. Establish communication with the SAMI.

4. Click ‘Stop’. You may now download your data.

2.5 AFT Stop Procedure

1. Attach communication cable to computer.
2. Establish communication with instrument by clicking on the ‘Serial Open’ button
3. In the Control window, click on ‘Stop’ button.

2.6 Download Data

1. Once you stop the instrument, you can download the data by clicking on the ‘Download’
button. The data stored on your instrument will be copied as a text file to a location you
select on your computer. A default name of ‘SAMI_UnitName_DDMMYY’ will appear in
the save dialog window. If you encounter an error while downloading, try downloading
again. The data is not erased from the SAMI until you click on the ‘Erase’ button.

2. To view the downloaded data, click on the ‘Open Data File’ button in the Control window.
Select the file you wish to view, and under the ‘Column set’ dropdown menu select ‘CO2’
and then click on the ‘Parse File’ button. Data can be viewed as a Spread Sheet or a
Scatter Plot. You can export results by clicking on the ‘Export All Data’ button.
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2.7 Real Time Data

To view real time data click on the ‘Real Time Data’ button. Under the ‘Column Set’ dropdown
menu, select ‘CO2’, and then click on the ‘Make View Win’ button. This will display the Year
Day, Temperature, CO2, and Battery Voltage. You can view as a Spread Sheet or Scatter Plot.

Choose Columns For Live Stream Viewing

Please select what data you want to view:
Column Set| » CO2 [ ¥ View Cached Records
pH
C02 Raw
PH Raw
All (raw)
GPS_Solo
C02_GPS
ﬁ DateTimeCO2 e (ﬁ
—— T Stop JIREaloiV I Vi
Edit List...

Figure 5. Real-Time Data
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3. Introduction to the SAMI2/AFT-CO2

3.1 What’s in the box

SAMI2-CO,

The rugged instrument case for your SAMI should contain the following upon arrival:
SAMI-CO; Instrument

SAMI Operating Manual

Communication/Power Cable

SAMI Software CD

Any external instruments, extra batteries or reagent ordered, though these may ship
separately.

bk =

Your stainless steel mooring cage, if ordered for a SAMI, will ship separately.

AFT-CO,
The rugged instrument case for your AFT should contain the following upon arrival:
1. AFT- CO; Instrument
2. AFT Operating Manual
3. Communication/Power Cable
4. SAMI Software Disc
5. Inlet pressure gauge assembly
6. Any external instruments or reagent ordered, though these may ship separately.

If any of these materials are damaged or missing, please contact Sunburst Sensors
immediately.

11



3.2 Overview of Operation for Instruments

Instrument
(AFT or SAMI)
SAMI Client Software

Status and data records {live or download) l

R5-232 57 6K Conneclion

l Config and commands

’
.

The instrument collects raw optical signals Raw dat? rE;al i —+
and temperature, storing them in record format. e _'tt'f”' -4 download
Other records stored show status, error, ect. {_;'I_lﬁ a, Display of
All records are time stamped and saved to raw data real fime
memory, as well as being sent over serial. records upenldaia data
file T
\_> Tab delimited
export of
Client configures, launches SAMI. Program calculated
converts raw data to calculate pH or pCO2 {and/or raw)
{depending on model) and temperature. data

‘ |

Figure 6. Operation Overview

Figure 3 above gives an overview of how the SAMI-CO, operates and interacts with the SAMI-
Client software. The instrument uses a time-stamped “records based” system to store and
transmit data. There are two main types of records; Data and Status. Data records consist of
raw measurement data, while status records contain information about the state of the
instrument (start, stop, battery low, error, etc.)

Once running, all records are store to internal memory for later download. Additionally they are
transmitted over the serial port, though the port only wakes up long enough to send this data to
save power.

Data records that are transmitted to the client can be displayed in real time via the ‘Real Time
Data’ button (enabled once data is detected). The user selects a ‘column set’ to choose which
quantities to view. Data can be shown in columnar (spread-sheet) display or as a graph. The
SAMI-Client comes with a variety of existing column sets, but the users may create their own as
well.

The SAMI-Client software sends configuration data (start time, sampling interval, etc.) and

commands to the SAMI (start, stop, erase, etc.) It also allows the download of data from the
instrument. Data is downloaded into a text file that contains the configuration data and raw

12



signal intensities as well as any status records. The user can then open and ‘parse’ that file
using the ‘Open Data File’ button or menu item. Again, the user selects ‘column sets’ to choose
which data to display.

Data can be exported to tab-delimited files for use in other graphing or analytical software from
the data viewer.

3.3 Software Installation

The SAMI2/AFT-CO; requires the use of its own client software for programming, download and
data interpretation.

SAMI Client Installation

Instrument software is available for both Windows (XP and later) and Mac (OS X). To install the
software, simply insert the SAMI/AFT Software disc, navigate to the ‘SAMI-Client Application’
folder and drag the folder for your computer platform to an appropriate location on your hard
drive. You may want to create a shortcut to your application, but it is important that the
application itself remain in the folder with the various sub-folders and other files for it to operate
correctly.

USB Serial Driver

Also on the disc is the driver for the serial-USB converter that is part of your communication
cable. Most modern computers will already have appropriate drivers installed or automatically
install this driver from the internet. If your computer doesn’t recognize the USB-serial converter
when the cable is plugged in, you can opt to install from this folder. You may also use the
internet to download the latest driver from http://ftdichip.com/Drivers/VCP.htm

3.4 Establishing Communication

Once SAMI Client has been installed as above, you may establish communication with your
instrument:

Please note that the cable provided with the instrument is for bench-top programming
and download of the SAMI/AFT. It is NOT submersible!

3.5 SAMI’'s

The black communication cable included with your instrument will have a 6-pin bulkhead
connector on one end and on the other end, two diverging cables: a USB-serial converter and
banana plugs. The communication cable’s bulkhead attachment should be attached to the 6-pin
bulkhead on the top of the instrument. The dot on the cable should be lined up with the largest
diameter pin on the SAMI bulkhead connector. If you have multiple bulkhead connectors, for
external instruments, the comm./power bulkhead will be indicated by a ‘C’ stamped onto the
housing.

The black (ground) and red (positive) banana plugs should be connected to a DC power supply
set to 10V to 13V DC. The USB connects directly to one of your computer’s USB ports.

13



o

in Connection

COM Ground

External Power Ground
Tx

©

@
© © :Tz

@ @ External Power High (13.5 V max)

oOuh wWwN =

* Communication is RS-232

SAMI Bulkhead
(Impulse p/n XSG-6-BCL-HP)

Figure 7. SAMI 6-pin connection.
3.6 AFT’s

The black communication cable included with your instrument will have a 6-pin connector on
one end and on the other end, two diverging cables: a USB-serial converter and an AC power

plug. The communication cable’s female bulkhead attachment should be attached to the side of
your SAMI instrument.

Bulgin power/communication connection for AFT.

Bulgin PX0413

Comm/Pwr
Pin 1 - DTR
Pin 2 - RXD
Pin 3 -TXD

Pin 4 — serial GND
Pin 5 — Power +
Pin 6 — GND

Once your instrument and computer are properly interfaced, you may start communicating
with the instrument. Under Preferences (in the Edit menu for PC’s, and in the SAMI Client menu
for Mac’s) select the appropriate serial port. Click the Serial Open button to establish
communication with your SAMI. The indicator next to the Serial Port text will specify if your

SAMI is interfaced with your computer. A red dot indicates a closed serial port while a green dot
indicates an open serial port.

Green dot indicates an open communication

o N : ;
- Serial Close Serial Port: ® usbserial-A4RCGQCO

Port power on until disconnect.
Connected

Serial Open/Close button engages and
disengages communication

Figure 8. Instrument Interface

Failure to connect usually indicates that the wrong port has been selected. Double check your
port settings if you cannot connect. See also the troubleshooting section.
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4. Hardware Overview

4.1 SAMI

The SAMI consists of a pressure housing, sampling area, pump/valve housing, and the reagent
housing. These are described below.

Pressure
Housing

Pump/Valve
Housing

Reagent
Housing

Figure 9.
Hardware Overview

Pressure Housing: The pressure housing contains the
controller board, batteries and optics. The communication-power
bulkhead fitting is located on the top of the housing. Other
bulkheads fittings will be present if external instruments are
being supported.

Sampling Area: Wrapped in a protective perforated brass
housing (not shown), this area is open to the environment. It
contains the flow cell, the gas-permeable membrane, fiber optics
and thermistor.

Pump/Valve Housing: This pressure compensated housing is
filled with low viscosity silicon oil to maintain a hydrostatic
pressure environment for the pump and valve contained within.
A diaphragm on the bottom of the housing communicates
external pressure. The pump drives reagent through the system,
while the valve selects between reagent and blank (de-ionized
water).

Reagent Housing: The reagent housing holds and protects the
reagent bags but is open to the environment to maintain
pressure equilibrium. Found on the bottom of the instrument, the
large bag contains indicator solution and the small bag contains
de-ionized water.
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Communication — Power Connection: The SAMI uses bulkhead connections made by

Impulse. To communicate with the instrument, remove the bulkhead cover plug by unscrewing

the locking collar and pulling firmly up. Take care not to unscrew the bulkhead itself, which
requires adequate torque (15 in-Ib) to
maintain its seal. To connect the

Cable assembly communication-power cable, align the
bump near the end of the cable with
the large #1 pin and push down firmly.
Before deploying the SAMI be sure to
replace the bulkhead cover and screw

Locking collar (threaded)  gown the locking sleeve to protect the

bulkhead pins from corrosion.

Alignment bump

Pin 1 (large)
The instrument uses the RS-232
communication protocol. The figure
below shows the pin-out of the
Impulse 6 pin bulkhead bulkhead as you look down on it.
The Tx line transmits data out and
while the Rx line is how commands are
sent to the unit. The RTS line tells the
instrument that it is connected to the client software. While it is ‘high’ the SAMI/AFT will send out
status strings about once per second. If connecting to a terminal, or external logger, keep RTS
off. RTS on the client software expires after 3 minutes to save power. (See software section
below.)

4.2 AFT
The AFT is divided into four sections:

Electronics: backup battery, fiber optics, and electronics.

Reagent Bag: Found on the bottom of the instrument, it contains the bag of indicator solution.
Pump/Valve: it contains the pump and valve, the components that circulate seawater and
reagent through your instrument.

Sampling Area: where the seawater flows through. It contains the flow cell, mixer, fiber optics
and thermistor.

2

Sampling Area
Flow Chamber

Reagent

Electronics and|
Storage

Pump/Valve
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Input
(Lower
Fitting)

Output
(Higher
Fitting)

Connection

Power/Communication

Figure 10. AFT Hardware Overview

SAMI Client is your interface for your instrument, both SAMI and AFT. The SAMI menu is

divided into three different tabs to help you organize the information that you will be
communicating to your instrument.

The Control Tab is where you will find buttons that manage basic operations such as

establishing communication, downloading and erasing data, as well as launching and stopping

the instrument.

ot v (©) Som ety (3w tmeat)

Figure 11. Control Tab
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The Settings Tab is where the deployment parameters and settings will be configured. The
start time, interval between measurements, and any external device settings are set here.

"nn SAMI Clent v, 1.06

[ N 5 P N T L ¥ o 8 S LV

Figure 12. Settings Tab

The Utility Tab contains an interactive display that shows live data being collected. There are
also controls that will allow you to create a pumping cycle so you can easily flush the
instrument.

"N SAMI Cleest v, 1.06

Fhowten) swaiboces r  mm - [

rtacactive

Figure 13. Utility Tab
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5.1 File Menu

Open Data File
Imports data files for data processing.

Import Settings from File

Loads previously saved launch settings that have been created under
the Settings Tab. This feature will save you time once you have

decided upon your customized launch settings.

Save Settings As...

File Edit SAMI
Open Data File

Windows F

Import Hex File
Import Settings from File
Save Settings As...

Exit

About SAMI2 Client...

Stores launch settings from your Settings Tab so they may be easily loaded at a later time. The
“Import Settings from File” will load these settings which you have chosen under the SAMI Box

in the Settings Tab.

Exit (PC only)

Shuts down SAMI Client Software. This does not disrupt instrument operation.

About... (Mac)

Software credits and version number displayed in dialogue window.

5.2Edit Menu

The “Preferences” tool under this heading (PC only) is important for

communication with your instrument. If using a Mac, “Preferences”
is found under ‘SAMI Client’ menu. “Preferences” contains a drop
down menu that is populated with the serial ports on your computer.
To communicate successfully with your SAMI, the correct serial port
must be selected. If the correct serial port is not present in the list,
you may need to wait for the rest of the ports to be identified. Check
the “Open serial port and contact SAMI” box to automatically

establish communication with your instrument once the correct

serial port has been selected. You will also set your SAMI to default
to either Local Time or GMT on the “Preferences” page.

5.3 SAMI Menu

Read SAMI Settings

The SAMI Launch Setting programmed into your
instrument can be viewed by choosing this option.
A separate window will appear with the Settings
displayed in list format. This option is only active if
the SAMI is NOT running AND the “Port Powered”
box is checked on either the ‘Control’ or ‘Utility’

page.

19

Preferences..

Edit SAMI Windows Help

. Ctrl+,

® SAMI_Client 1.20 File Editrm Windows  Help

D M

Serial Close Serial Port: ® usbseria
lz‘ Port Powered 177 sec.

Connected

Read SAMI Sett
Update Firmware

Bulk Erase
Verify Erase
SpecialBaud...




Read/Edit SAMI Text

The text added to the SAMI under the “Edit Text” button on the Control Tab can be viewed by
selecting this option. This option is only active if the SAMI is NOT running AND the “Port
Powered” box is checked on either the ‘Control’ or ‘Utility’ page.

Update Firmware

This action will be performed when software updates become available through Sunburst
Sensors. As you receive or download newer versions of the SAMI Client, upgrades to the
firmware may accompany these. If required, an advisory message suggesting update of the
firmware will appear when you first connect to the instrument.

5.4 Help Menu

Various documents are available via the Help menu,
including this manual, release notes for the software

detailing what changes have been made, etc. SAvi AFT o MANUAL — 011112

SAMI Client Release Notes 1.20

Using SBE 37 with SAMI
View Sunburst Website Using the Aanderaa 4175 Oxygen Optode with the SAMI2
The “Sunburst Website” heading will direct you to View Sunburst Sensors Site

Send us Email

www.sunburstsensors.com for convenient access to our
business, research, and contact information.

Check for updates

Send us Email
Directs email to Info@sunburstsensors.com

About SAMI application (PC)
Brings up an information and credits window.

Check for Updates

If you have an internet connection the SAMI Client software will automatically check the
Sunburst Sensors website for updates to the software upon launch. You can manually check via
this menu item.

5.5 Control Tab — Serial Communication

Serial Open/Close

The Serial Open/Serial Close button engages SAMI Client software to communicate with your
instrument. To establish communication, attach the communication cable to your computer and
SAMI. In Edit > Preferences (PC), or SAMlapp > Preferences (Mac) select the appropriate
serial port. Click the Serial Open button to begin communication with your SAMI. The indicator
next to the Serial Port text will specify if your SAMI is interfaced with your computer. A red dot
indicates a closed serial port while a green dot indicates an open serial port.
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[ Control = Settings  Utility

" Serial Close ) Serial Port: ® usbserial-FTUTMBTS Baud: 57.6K
|| Re-power Sleeping after 180 seconds of inactivity
RTS is off

If the “Open Serial port and contact SAMI” box is checked in the Preferences page, the Serial
Open/Serial Close button will no longer be visible and the instrument will automatically try to
establish communication when it is powered on.

SAMI Preferences

Serial Port: | usbserial-ETUTMBTS |4 |

¥ Auto-open serial port
(Connects to SAM! when Client starts.,

| Use 9600 for logger or UIMM
{Control wil appear in Settings panel.)

Default to:
®) Local Time ) GMT
N\ o —

txt File extension for data files

oK)

5.6 Power Settings

SAMI Port Powered/Re-power

To conserve battery, the instrument communications will time out after 3 minutes, unless you
override this feature by selecting the ‘External Power’ radio button. If the port does time-out you
can re-open it by simply clicking the ‘Re-power’ check box. If communications has timed-out,
you cannot send commands to or program the instrument until the port is re-powered.

If the instrument is running, however, the instrument will send data out over the serial port after
each measurement or other event, even if the port is timed out. (The instrument powers up the
port just long enough to send data)

Save battery
On the SAMI, the Save battery option should be selected when not connected to external

power. This allows the instrument to go into time-out after 3 minutes and preserves the internal
battery. This function may also be controlled from the “Utility” tab. For the AFT, the “External
Power” button should be selected.
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Port power

() Save battery (3 min. time-out)
@ External power (no time-out)

External power (SAMI only)

If the instrument is connected to a 13 V DC power supply, you can select this option to keep
communication open with the SAMI at all times. If ‘External Power’ is selected, the message
“Port power on until disconnected” will appear under ‘Serial Port.’

This function may also be controlled from the “Utility” tab.

5.7 Control Tab - Deployment Controls

[~ Deployment Cycle Controls

This SAMI: Name: PO00S SN: 0012 Hardware: 0C pH Firmware: 26

Download

Config status: 24:52:06 Serial Port Opened

&I Run Status: Clock is not running Data Records: 0 Error Records: 0 Memory Used: 0

Edit Text
4| Flags: Erased
Full Status Flags: 4000Hex
Launch Erased
Stop

Download

The “Download” button will copy data stored on your instrument to a location you select on your
computer. A default file name of ‘SAMI_UnitName_DDMMYY’ will be suggested in the save
dialog. Data will not be erased from the instrument by using the Download function. If download
fails, try it again.

Erase

The “Erase” button will clear the memory on the instrument of the data that it previously
collected. To launch your instrument you must erase all data stored on it. If you wish to save the
data from your last data collection you MUST download the information before it is erased. If
you attempt to erase data before it has been downloaded, you will get a warning message “Data
has not been downloaded! OK will erase all data and settings!” To launch your instrument you
must erase all data stored on the instrument.

Edit Text
The “Edit Text” button allows you to add notes to the instruments memory. The notes will be

displayed in the data output files and can be accessed by following from the Toolbar SAMI >
Read SAMI Text.

Launch

Unless the SAMI has been erased, it cannot be launched. Prior to launch, use the controls in
the Settings Tab to configure the instrument — setting the start time, sample interval, etc.
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If you have set a launch time that has passed, you will get the message “Start is less than 10
seconds from now! Would you like to start in 10 seconds?” This may be OK for bench-top
testing, but if you require data aligned to the hour, you should program the start time
accordingly.

Stop
The “Stop” button will end the launch of your instrument and sampling will cease. Data will be

saved in the memory of your instrument.

5.8 Control Tab - Configuration status
In the Configuration section one of the following messages will appear:

Serial Port Opened
The SAMI has established communication with your computer.

Config loaded and SAMI started
Indicates that your program has launched and measurement collection has begun.

(#) of Pages downloaded
This message appears when a measurement sequence has been stopped and you have
downloaded a file.

Erased
The memory has been cleared and you may begin another measurement sequence.

5.9 Flags
The Flags section will display messages that indicate status:

Clock Started
The measurement sequence that you have programmed under the Settings Tab has begun.

Recording Started
Data is being collected and stored in your instrument’s memory.

Recording Stopped
The measurement sequence has stopped. The data has not yet been downloaded or erased.

Downloaded
The measurement sequence has been stopped and the data has been downloaded, but not
erased. Erase your data before continuing with another sequence of measurements.

5.10 Run Status

While the program is running, the Run Status will display the date, time, number of data files
collected, and the memory used. The Run Status section will remain blank if the program is not
running, the files have been downloaded, or the data file is erased.
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5.11 Control Tab - Battery, Temp, Externals

Clicking the “Read” button updates information on the battery
voltage, the temperature in Celsius, and the output voltage of any
external devices. The Re-power box does not need to be checked
in order to check battery, temperature, and external voltages.

Battery, Temp, Externals

Refresh ) Battery: 12.7V
Temperature: 22.31°C

Devicel: 0.00V
Device2: 0.00V
Device3: 0.00V
Photodiode: 0.00V

.
5.12 Settings Tab
0 SAMI Client v. 1.02
Control | Settings | Utility ‘
Start - Stop Prestart
The time and time zone settings of this computer will be used to set the SAMI clock. DI Pump w ‘

(O GMT @ Local Time
Monday, October 11,2010 14:50:00
Start: (2010 %) (10 0ctober [#) (11 1) (14 ¥ (50 9)

Year Month Day Hour  Minute 240

] 9600 baud

While waiting to start, pump Dl water at interval (CO2 only) :

Interval Minutes

Runduration (100 | Days [0 Hours

Ends: Wednesday, Janua
SAMI

ry 19,2011 14:50:00

SAMI CO2 (A+) 2}

30 Sample interval (mins)
168 | Cycles Between Blanks
[ Do Not Start with Blank Flush

Report the dark corrected ratios,
Sample/Reference for 434 and
620nm averaged over the
number of samples then battery
and temperature. Also report
raw data before and after
averaged data.

Device 1

Pump pul
Pump on to

. )

Serial+Power

M After SAMI Serial

Interval Minut
Power Select
@ Use 12V Power

(O Use Battery Power

O No Power out

(9600 %) Baud Rate
@ Send String

(O Wait for String

s String

Append: M CR WILF

Device 2
Generic Driver 2}
M After Sami rval Minut
I " Warm-up Interval seconds
1 # samples to average

Power Select Input Select

@ Use 12 Power @ sv

(O Use Battery Power (O Photodiode pin 5

O .
(O No Power out

Device 3
Power Out ™

™ After SAMI nterval Minutes
ik | Power on interval seconds
Power Select

@ Use 12V Power
() Use Battery Power

[2~ | on for seconds 45 | Characters to record

Figure 14. Settings Tab

Overview

The Settings Tab contains the various control panels used to configure the instrument prior to a
deployment. These control panels allow the user to set the start time and run duration, sampling
interval and so on, It is important to note that these settings are not sent to the instrument until
the user ‘launches’ the unit via the ‘Launch’ button in the Deployment Controls (see above).

Start - Stop
In the “Start-Stop” box in the upper left hand corner of the Setting Tab you will enter your

deployment start time and the run duration. You may enter the exact time you wish to launch
your instrument, accurate to one minute. Note that you may display your time in GMT or local
time.

When you enter the run duration in the specified box, a message appears below which will
calculate the end time and date.

In the event that the start time has passed you will receive a message informing you the start
time has passed. When you Launch your instrument a message box will ask if you wish to begin
sampling in 10 seconds. By selecting ‘OK’ measurements will begin immediately, otherwise you
may select a new start time by selecting ‘Cancel.’
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[~ Start - Stop
The time and time zone settings of this computer will be used to set the SAMI clock.

" GMT  * Local Time
Friday, January 01, 2010 12:00:00
Stall:lZUlD ﬂ IlJanuary ﬂ Il ﬂ ID ﬂ IUD Ll
Year Month Day Hour  Minute

Run duration [100 Days 0 Hours

Ends: Sunday. April 11, 2010 12:00:00

5.13 SAMI Panel

SAMI The SAMI control panel is where you
[ SAMI CO2 (A+) 3 will enter the sampling interval and
blank interval. In the drop down menu in
30 sample interval (mins) Pump pulse (sec/16) the top center of the box, please select
168 | Cycles Between Blanks ampentemes seetel - gAMI-CO2 (A+). The sample interval
Of sampies/meas H . H
1 Do Not Start wih Blank Fush Sk vl must be entered in mlnut(_es and with a
_ time of no less than 10 minutes. The
Report the dark corrected ratios, Reagent cycles . . .
Sample/Reference for 434 and ) blank interval will automatlcally be

620nm averaged over the f pump interval (sec)
number of samples then battery
and temperature. Also report

raw data before and after extra pump cycles
averaged data.

calculated by the software based on the
sampling interval occurring every 3.5
days. You can over-ride this by
manually entering a value, though it is
not recommended.

It is recommended that deployments start with a blank cycle, but for some testing a user may
wish not to do this. Checking the ‘Do Not Start with a Blank Flush’ will allow user this flexibility.
The grayed-out controls on the right hand side of the control panel are not user adjustable, but
visible for trouble shooting and support.

Meas after each pump pulse

5.14 Pre-Start

The Pre-Start function contains routines that occur before the programmed SAMI Launch Time.
A flushing interval can be selected by choosing the ‘DI pump’ from the drop-down menu. The DI
Pump will run de-ionized water (blank) through your instrument at selected intervals. The
‘Record Temperature and Battery’ function will write temperature in degrees Celsius and Battery
Voltage to the data file. After selecting the function and setting the time interval, you must
launch the SAMI from the Control Tab.

Prestart

Record Temperature and E ¥

While waiting to start run:

120 Interval Minutes

25



6. External Device (Device 1, 2, 3)

The SAMI supports up to 3 external devices, such as PAR sensors, fluorimeters, dissolved
oxygen optode, or similar. It can read and log device output. It will support one RS232 serial
device and two 0-5V output devices, or three 0-5 V devices with no serial device. These devices
can be scheduled with reference to the SAMI’s own measurements, occurring immediately after
the measurement has completed, or on a set interval.

Contact Sunburst if you wish to control an external device with the SAMI. The SAMI is not
configured to support external devices in the base model — i.e. there is no wiring to support the
externals.

6.1 Generic Driver

The generic driver supports 0-5V input. Select the Device 1

scheduling of the device by specifying whether to activate [Generic Drver [
after the SAMI measurement or at a fixed interval. The IV after SaI 10 Interyal Mrutes
‘Warm-Up Interval’ allows the external device to stabilize [t warm-up Interval seconds

before measuring and should be set in accordance with [+ #samplestoaverage
manufacturers suggestions. The ‘# samples to average’ Power Select e
allows multiple readings to be averaged. The power Qi 9
selection allows devices that have their own power Pl BRI
conditioning to access the instrument batteries directly
and thereby increase efficiency. Some devices, such as a
PAR sensor, require no power.

" No Power out

6.2 Utility Tab

The utility tab is generally used for trouble-shooting and to flush the SAMI prior to storage or at
the end of a deployment.

Serial Port Open-Close, Port Power
These functions can be controlled from the “Control” tab or from the “Utility” tab. See
explanation of their functions under “Control” tab.

Interactive

The Interactive Display will give you live feed on the data that your instrument is collecting. With
each measurement, a string of information is written to the window. The first line will start with
“Launch.” The next line will have the headers for the following columns of data. Data will be
written to the screen each time a measurement is taken. This information is mostly for trouble-
shooting. The records are not processed (i.e. pCO,, etc is not calculated). At the top of the
display you will notice a button marked “Clear” which will clear the display. The Clear button will
not erase data from the memory.

Pre-Start

The instrument can be programmed to perform functions while it is waiting to start. If this has
been configured, will pump de-ionized water or read battery and temperature as programmed in
the Prestart section of the Control Tab.
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Sample
The Sample button will run a measurement according to your programmed specifications. The
measurement will not be saved in your stored data but will display in the “Interactive” screen.

Blank

The Blank button will begin a blank measurement according to your programmed specifications.
The blank will not be saved in your stored data but will display in the Interactive screen and will
be used for absorbance calculations from subsequent data collection.

Device 1, 2,3
This will take a reading of the device selected. The data will not be saved in your stored data but
will display in the “Interactive” screen.

Power Externals
The “Power External” buttons located beneath the Interactive screen and can power the pump
or valve, or an external device using 12 V or battery voltage.

Power Externals

@ Al off () Devicel Battery () Devicel 12V
() SAMI Valve () Device2 Battery () Device2 12V

(©) SAMI Pump () Device3 Battery () Device3 12V

Cycle Pump

The Cycle Pump function is available to flush your instrument. Flushing is an important function
for the health of your SAMI as well as to maintain a clear optical path. To flush the CO,
instrument you will need to set ‘# cycles’ to 30, check the “Open Valve” box, and click on ‘Run.’
The instrument will need to be flushed after each deployment to prevent reagent from
drying in the membrane.

The “Open Valve” box will initiate the valve during the pumping cycle. By checking this box, the
initiation of the valve will pump de-ionized water in your instrument. The “# cycles” refers to the
number of 50 pL pumps you wish to flush through the instrument. You may choose up to 99.
“Interval (secs)” refers to the amount of time between each 50 yL pump (1 sec or greater).
Leave this interval at 3 seconds unless otherwise instructed by Sunburst Sensors. The AFT
interval should be 15 seconds. The ‘Run’ button initiates the pump.

Cycle Pump

N ;
("  Run ) #cycles 5

{ p

pH Flush Interval (sec) 3

1 Open Valve

6.3 Viewing Data

Data can be viewed in real time or imported from a file after download. On the Controls Tab
page the ‘Read Real Time’ button becomes activated when the software detects a new
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measurement record (if you have connected to a SAMI that is already running) or immediately
after the ‘Launch’ button is pushed. Data can be imported by pushing the ‘Open Data File’
button or selecting ‘Import Data File’ from the ‘File’ menu.

Data Overview

Raw SAMI data is stored as records while the SAMI is running. These same records are
transmitted over the serial port as well, so the client software will recognize and interpret them in
real time.

Raw Record Structure

There are 2 main types of records recorded by the instrument. There are data records and
information records. Every record leads with an identifying number (Record Type) and a 4-byte
time stamp. Information records note events such as ‘start’, ‘stop’, ‘battery low’ and possible
errors if one should occur. Data records follow the type/time fields with a series of fields
composed of the various readings (e.g. temperature, dark signal) needed for the measurement.
In raw format these readings are not especially informative except in trouble-shooting situations.

Computed fields

Computed fields consist of data derived from the raw records. For example the raw thermistor
reading is stored as a 12-bit number (0-4096). The temperature field is the temperature
calculated from that raw number. Time is stored as a 4-byte number reflecting total seconds
since 1/1/1904, while calculated fields allow time to be displayed in a variety of formats.

Viewing real time data.

The ‘Real Time Data’ button plots data that is being collected by the instrument in real time.
When you click on the ‘Real Time Data’ button, a pop-up with a drop down menu titled ‘Column
Set’ will appear. SAMI Client has a number of previously compiled parameter sets that you can
choose from in ‘Column Set’ Lists’. Choose the data from the list (e.g. CO2, pH, CO2 Raw, pH
Raw, All (raw), GPS_solo, CO2_GPS) that you want to view. Select ‘Make View Win'’ to view
the data.

e T T bz

P i ol Tl

] | [Tl T |

A new window will open with data in spreadsheet format. A drop down menu titled ‘Display
Type’ allows you to view data in spreadsheet, scatter plot, or histogram format.
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Spreadsheet
The Spreadsheet format will allow you to view the data being collected as a list.

Scatter Plot
Under the Scatter Plot data display select the x-axis and y-axis parameters you wish to plot.

13
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Histogram
This feature is not yet implemented.

Creating your own set of parameters to view

If a pre-fabricated set of parameters does not include the information that you would like to view
you may create and name your customized Column Set List. By selecting “Edit List...” from the
Column Set drop-down window you will receive a Set List Editor. You may adapt a previously
existing list or create a new one.

Editing a pre-existing list is done by highlighting the list you wish to edit and clicking the button
in the lower right hand corner labeled “Edit”. A list of the parameters appears in a new window.
The left side window labeled Columns will display all parameters contained in the Column Set
List. Clicking the “Add” button below the window will make available two drop down menus on
the right side of the window. The “Column Type” drop-down menu will provide you with the
classifications of parameter we have to choose from. You may be interested in viewing raw data
or processed data. By selecting the type of data you can choose the exact parameter you wish
to plot in the Column Name drop-down menu below. There you may select from a number of
different parameters to populate your Column Set List: sample or reference signals of a specific
wavelength, ratio of signals to reference, temperature, time, battery voltage, and CO2.

To create your own Column Set List, return to the Column Set List editor. Select “Add” from the

buttons at the bottom of the window. A Column Editor will appear with an untitled Column Set
List. Name your Set List and populate the parameters in the same fashion as described above.
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6.4 Data Processing

Once data has been downloaded you can view raw and processed data with SAMI Client
software. Go to ‘File’ menu and select ‘Import Data File’. A window will appear that asks you to
select what data you want to extract from the file. In the drop down menu, select ‘CO2’ to view
processed data. To view raw data, select ‘CO2 Raw’. Next, click on ‘Parse File’ button. Data can
be viewed as a spreadsheet or Scatter Plot and exported as a text file. Although you can only
view the first 500 rows of data you can process and export the entire data file.

Import SAMI File

File: SAMI_C0012_150610c.txt (1.77 KB)

Please select what data you want to extract from this file:

Column Set: [ CO2 =] M Remove Empty Columns
s Gar ol m— (" pasefie )
Cancel ) Parse File
600 File: SAMI_C0003_040510.txt
(] stream Live Data (Clear Data ) (_Reparse File/Change Columns )
Display Type:  Spread Sheet =)
(oo
Export All Data Showing first 29 of 29 rows
Year Day Temperature C co2 Battery Voltage
123.88311
124.00002
124.00075 7.87 1139
124.04181 838 314.21319164 1167
124.08347 8.91 307.58086504 1167
124.12514 9.11 305.14699254 11.67
124.16681 9.40 302.58621189 1167
124.20847 9.60 299.58203431 1167
124.25014 931 302.19434364 1167
124.29181 7.54 298.16715363 1167
124.33347 6.94 302.68629601 11.66
124.37514 6.70 300.0329192 1166
124.41681 7.03 319.93026434 1165
124.45847 7.51 324.24374867 1165
124.50014 7.18 31179810156 1165
124.54181 7.69 309.14786064 11.65
124.58347 8.51 316.39791761 11.66
124.62514 9.00 303.49500929 1167
124.66681 9.56 316.97018191 1167
124.70847 9.94 306.98717318 1168
124.75014 10.14 313.57065485 11.68
124.77825
124.77825
800 File: SAMI_C0003_040510.txt
D Stream Live Data _Clear Data ) (_Reparse File/Change Columns
Display Type: [ Scatter Plot ]
X axis: ( Year Day %) xmin[12355 | vimn[64 Y2 Min 32 Vertical Grid
v B xmm12e83 |vivax[105 | vomax[357 (] Horiz Grid
Y2 axis:( €02 2] Showing 19 of 19 points (every point) Print
R e
[ -
| . /
| . /
| > yad
[/ /
/ ’
| LN ~
| \ N
| . .
« Day

6.5 External Devices

The SAMI has the capability to support up to three external devices, supplying power if
necessary and read 0-5VDC output from the device(s). The SAMI can support one RS-232
serial device in place of an analog device. Examples supported by the SAMI include Seabird
CTD, Aandera Oxygen optodes, and Licor's PAR sensors.
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By notifying Sunburst Sensors of your interest we can work with you on adapting your
instrument for this capability.

7. Troubleshooting

These are a few common questions that we receive at Sunburst Sensors. If you do not see your
question here, please contact us.

What do | do if | cannot communicate with the instrument?

You will not be able to communicate with your instrument if the correct serial port has not been
selected. In SAMI Client select EDIT > PREFERENCES and try choosing another serial port
from the menu. Many times it may take some time for the computer to fully populate the list. You
may need to wait until another serial port appears in the drop-down menu. The COM port on the
PC will typically be the last one in the list. On a Mac the serial port will be named ‘USB-serial
XXXXXXXX’ where the X’s represent alpha-numeric characters.

File Action View Help

as |5 = | —SE | Foo lamrgs | Desw | [msa
4 SUNBURST1720
.\ Batteries —

€3 Bluetooth Radios
418 Computer

- )% Mice and other pointing devices
| Modems

+- B Monitors
#-&¥ Network adapters /
577 Ports (COM & LPT)

T3 USB Serial Port (COM2)

& [ Processors
1B sl

On Windows operating systems (XP, Vista, 7) it is sometimes helpful to go to the ‘Device
Manager’ (Control Panels->System and Maintenance->System) and look for the Ports to verify
your USB-Serial converter is working. There should be at least one ‘USB Serial Port’ under
‘Ports (COM & LPT)’. Double click to open and verify that it is the ‘FTDI’ converter and not some
other device. Use this port number in the SAMI Client preferences.

If you do not see a ‘USB Serial Port’, it is likely that you will need to install the driver. Try
unplugging and re-plugging the cable to the PC. This should prompt an install dialog. The
driver is on the install CD and can also be found here: http://ftdichip.com/Drivers/VCP.htm

On some PC’s switching to another USB port will solve the problem. Also, it is occasionally
useful to restart the SAMI Client software and/or the PC itself.

What happens if the signals drop?
This is very likely due to an obstruction in the path of the optical cell. Commonly, it is bubbles
which can be flushed out by continually pumping. If you use the Cycle Pump function on the
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Utility Tab of SAMI Client to pump deionized water through the instrument the problem will often
be solved. Also, setting the SAMI on its side or in a bucket of water and cycle the pump will
solve the problem.

What should the signal intensities be?

Signal intensities can range from 0 to 4096. If any signal intensity is at or near 4000, the
channel may be saturated with light, giving erroneous results. Reference and blank signal
intensities should be greater than ~1500. Lower intensities will result in higher noise in
absorbance and thus pH measurements. However, if during blank measurement signal
intensities are low but reference intensities are not, the flow cell needs to be flushed. Dark
signals will normally range from ~50 — 200. Higher or erratic dark signals could indicate an
electronic problem with your SAMI. Call Sunburst if any abnormal signals cannot be rectified.

How do | flush my instrument?

There is a function on the Utility Tab of SAMI Client labeled “Cycle Pump”. Under this section
you may flush your instrument without disrupting the programmed measurement routine. You
MUST select “Open Valve” to flush with de-ionized water. Set the SAMI on its side orin a
bucket of water and cycle the pump.

My Spreadsheet Maker did not populate the Column Set List!

It is very likely that the file included on your instrument disc was not copied over to your
computer. Please double check that every file on the disc has been successfully transferred
including a file labeled “ColumnSettings.txt”.

What if | cannot rectify my problem?

Contact Sunburst Sensors, our information is found on the front of this manual. We will work
with you to find the fastest and most economical solution to your problem. Never hesitate to give
us a call or send us an e-mail.

8. SAMI/AFT —CO, Theory of Operation

8.1 Overview

The partial pressure of carbon dioxide (pCO,) is analyzed by equilibrating a pH sensitive
indicator solution (Bromothymol Blue) to the sampled seawater. Aqueous carbon dioxide in
seawater diffuses across the permeable silicon membrane equilibrator producing a colorimetric
change in the indicator solution. The equilibrated indicator solution is pumped through an optical
cell where the optical absorbance is measured at the two wavelengths corresponding to the
peak absorbances for the protonated and deprotonated forms of the indicator. By calibrating the
instrument’s response over the range of interest, the pCO; can be calculated based on the
calibration curve. Periodic blanks are run to correct for drift of the electro-optical system, while
reference measurements of the LEDs correct for interim deviations.

8.2 Equilibrium Reaction

In the instrument, gaseous CO, diffuses through a silicone rubber tubular membrane, forming
carbonic acid, which changes the pH of a Bromothymol Blue (BTB) indicator solution. The
response is described by the following equilibrium:
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# SAMlgas phase response

Figure B: GaS phase 0.6 + Theoretical response
calibration data for SAMI/AFT- o
CO.,. The theoretical curve is =

also shown. Since the pKj, of 047 s
bromothymol blue is not #
accurately known at low ionic os s
strength, a pK, that fit the , -
observed data was used (7.435 /

at 20°C). RCO; is the right side 0.0 /

of Equation 3. b

100 200 300 400 500 600

- Ka‘ + 2-
H =——H +I" (1)

where HI"and |* are the protonated and unprotonated forms of the diprotic indicator

bromothymol blue, H* is the hydrogen ion concentration, and K, is the indicator equilibrium
constant. The response is calculated from a ratio of absorbance measurements at the
absorbance maxima of HI" (434 nm) and I* (620 nm) forms of BTB:

R = As20/As34 (2)

where Agyo and Asz4 are the measured absorbances. When the absorbance ratio R is used in
the log form of Equation 1, it can be seen that the ratio is directly related to the solution
composition:

R_
pH=pKa'+10g(—e‘ ) (3)
e, —Re3

where pK,' is the negative log of the apparent dissociation constant and the e’s are ratios of the
HI and I* molar absorptivities. The instrument response (RCO,) is calculated as the right side
(log) term of Equation 3. The instrument response is therefore only dependent upon the
indicator solution pH and indicator equilibrium constant for systems with identical wavelength
bandpass (e’s). The indicator solution pH is fixed by the solution alkalinity and CO; equilibrated
across the gas permeable membrane. Indicator solutions are very stable and, if periodic blank
readings are obtained, the instruments have excellent long-term stability, i.e. no drift over
month-long periods. With its current tubular silicone rubber membrane (165-um wall thickness),
the response time is ~5 minutes.

To determine the absorbance ratio R, the actual absorbances must be obtained, that is A = —
log(l/l,) where |, is the light intensity transmitted with no absorber present (the blank) and | is the
light intensity transmitted through the COj-equilibrated indicator solution. The measurement of |,
requires flushing the cell with a blank solution (de-ionized water) which consumes significant
power, time, and indicator. As a compromise to running water blanks between every pCO,
measurement, we have found that running a blank every 2-3 days is sufficient if reference light
intensity corrections are made. A pCO, precision of £0.5 - 1 patm is routinely achieved with the
SAMI/AFT-CO; using these procedures.
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The instrument response (RCO.) is empirically determined through calibration with variable CO,
gas concentrations in a thermostated chamber. To obtain multiple points, mass flow controllers
are used to dilute a high concentration CO, standard. The CO, mole fraction is continuously
monitored with a Li-COR CO; analyzer (NDIR) calibrated with NOAA CMDL primary gas
standards. The SAMI/AFT and NDIR data are combined to give a second-order polynomial
calibration curve.

Using calibration data, the instrument pCO, accuracy is estimated to be ~1 patm. The theory
was also used to determine an equation to calculate a temperature coefficient, from RCO, and
temperature, for each CO, measurement. This temperature coefficient is used to correct the
CO; value at temperatures differing from the calibration temperature.

3.0 1
Results from water phase
2.0 1 calibrations of 4 different SAMI-
1.0 4 COgs. The difference is calculated
from the CO, standard and the CO,
0.0 1 calculated by the instrument. The
104 changing response early on is
caused by the slow equilibration of
-2.0 1 the water surrounding the
2% instrument membrane. Accuracy is
estimated to be ~1 uatm using the
-4.0 + : ' i data after 1.5 hrs only. Precision is
0 1 2 3 <1 uatm.
Time (Hour)
Optical Path

The instrument uses pulsed LEDs with narrow band filters at wavelengths corresponding to
maximum optical absorbance for the protonated and deprotonated forms of the reagent. A
reference photodiode tracks changes in the light sources. Light is transmitted to and from the
flow-cell via 800-um optical fibers. In the instrument the flow-cell optical path length is 0.75 cm.

Fluid Path

The instrument uses a 50 pl solenoid pump to drive reagent through the system. A solenoid
valve allows one pump to be used for blank and indicator solutions. The sample’s baseline
signal is established by taking measurements while pumping nano-pure water through the flow-
cell. After establishing the baseline signal, the system is flushed with reagent. Fresh reagent is
pumped into the gas permeable tubular membrane and the reagent equilibrates with CO; in the
membrane that has diffused from the seawater for a minimum of 15 minutes. Once the
equilibration time is complete the reagent is pumped to the optical cell to measure a sample
signal. The signals are used to calculate absorbance and pCO is calculated using your
instrument-specific calibration curve.

References

For more information see the following reference: DeGrandpre, M.D., Baehr, M.M. and T.R.
Hammar. (1999). Calibration-free optical chemical sensors, Anal. Chem., 71, 1152-1159.
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9. Care and Maintenance

The instrument requires periodic re-calibration and refurbishment and should be returned to
Sunburst Sensors at least annually.

You may clean the exterior of your instrument with a mild soap and water. Do not use abrasive
materials to remove any sea life that has fouled the instrument.

All other care and subsequent refurbishment should be conducted by Sunburst Sensors unless
previously advised by a Sunburst representative.

10. Warranty

Sunburst Sensors, LLC warrants to the original purchaser that instruments manufactured by
Sunburst Sensors shall be free from defects in materials and workmanship for the life of the
product. Under this warranty, the instrument will be repaired or replaced as deemed appropriate
by Sunburst Sensors without charge for parts or labor when the instrument is shipped prepaid to
our location. This warranty does not apply to any instrument which has not been installed or
used in accordance with proper operation and installation specifications. Sunburst reserves the
right to void any warranty, written or implied, if upon Sunburst’s examination of the instrument
reveals failure was due solely, or in part, to accident, misuse, neglect, abuse, alteration,
improper installation, unauthorized repair or improper testing by the buyer. Sunburst shall not be
liable under any circumstances for indirect, special, consequential, or incidental damages in
connection with, or arising out of, the sale, performance, or use of the instrument covered by
this warranty. When a Product is returned to Sunburst Sensors for refurbishment/recalibration
this service is considered normal preventative maintenance. Recalibration of your instrument
shall not be treated as a warranty service unless recalibration of your instrument is required as
the result of repairs to the instrument pursuant to this Warranty. Your instrument may only be
repaired and refurbished by a certified, trained specialist from Sunburst Sensors, LLC. Breach
of this requirement without prior consultation from Sunburst Sensors may result in the voiding of
your Warranty.

If you would like more information on your SAMI for self repair or refurbishment please contact

Sunburst Sensors. After notification is given that the interior of the instrument will be accessed,
Sunburst Sensors is no longer responsible for defects incurred under the by the user.

11. MATERIAL SAFETY DATA SHEET

1. IDENTIFICATION OF THE Fax : +18003255052
SUBSTANCE/PREPARATION AND OF THE Emergency Phone # : (314) 776-6555
COMPANY/UNDERTAKING
Product name : Bromothymol Blue sodium 2. HAZARDS IDENTIFICATION
salt Not a hazardous substance or preparation
Product Number : B7271 according to EC-directives 67/548/EEC or
Brand : Sigma 1999/45/EC.

: Si -Aldrich
ggé?)pggryucglg?:et dric 3. COMPOSITION/INFORMATION ON
SAINT LOUIS MO 63103 INGREDIENTS
USA Synonyms : 3',3"-
Telephone : +18003255832 dibromothymolsulfonephthaleinsodium salt
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Formula : C27H27Br2NaO5S

Molecular Weight : 646,36 g/mol
CAS-No. EC-No. Index-No. Classification
Concentration

Bromothymol Blue sodium salt
34722-90-2 252-169-7 - - -

4. FIRST AID MEASURES

If inhaled

If breathed in, move person into fresh air. If not
breathing give artificial respiration

In case of skin contact

Wash off with soap and plenty of water.

In case of eye contact

Flush eyes with water as a precaution.

If swallowed

Never give anything by mouth to an unconscious
person. Rinse mouth with water.

5. FIRE-FIGHTING MEASURES

Suitable extinguishing media

Use water spray, alcohol-resistant foam, dry
chemical or carbon dioxide.

Special protective equipment for fire-fighters
Wear self contained breathing apparatus for fire
fighting if necessary.

6. ACCIDENTAL RELEASE MEASURES
Personal precautions

Avoid dust formation.

Environmental precautions

Do not let product enter drains.

Methods for cleaning up

Sweep up and shovel. Keep in suitable, closed
containers for disposal.

7. HANDLING AND STORAGE

Handling

Provide appropriate exhaust ventilation at places
where dust is formed. Normal measures for
preventive fire protection.

Storage

Store in cool place. Keep container tightly closed
in a dry and well-ventilated place.

8. EXPOSURE CONTROLS/PERSONAL
PROTECTION

Personal protective equipment

Respiratory protection

Respiratory protection is not required. Where
protection from nuisance levels of dusts are
desired, use type N95 (US) or type P1 (EN 143)
dust masks. Use respirators and components
tested and approved under appropriate
government standards such as NIOSH (US) or
CEN (EU).
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Hand protection

For prolonged or repeated contact use protective
gloves.

Eye protection

Safety glasses

Hygiene measures

General industrial hygiene practice.

9. PHYSICAL AND CHEMICAL PROPERTIES
Appearance

Form powder

Safety data

pH no data available

Melting point no data available

Boiling point no data available

Flash point no data available

Ignition temperature no data available
Lower explosion limit no data available
Upper explosion limit no data available
Water solubility no data available

10. STABILITY AND REACTIVITY

Storage stability

Stable under recommended storage conditions.
Sigma - B7271 www.sigma-aldrich.com Page 3 of 4
Materials to avoid

Strong oxidizing agents

Hazardous decomposition products
Hazardous decomposition products formed under
fire conditions. - Carbon oxides, Hydrogen
bromide gas, Sulphur oxides, Sodium/sodium
oxides

11. TOXICOLOGICAL INFORMATION

Acute toxicity

no data available

Irritation and corrosion

no data available

Sensitisation

no data available

Chronic exposure

IARC: No component of this product present at
levels greater than or equal to 0.1% is identified
as probable, possible or confirmed human
carcinogen by IARC.

Potential Health Effects

Inhalation May be harmful if inhaled. May cause
respiratory tract irritation.

Skin May be harmful if absorbed through skin.
May cause skin irritation.

Eyes May cause eye irritation.

Ingestion May be harmful if swallowed.

12. ECOLOGICAL INFORMATION
Elimination information (persistence and
degradability)



no data available

Ecotoxicity effects

no data available

Further information on ecology
no data available

13. DISPOSAL CONSIDERATIONS
Product

Observe all federal, state, and local
environmental regulations.
Contaminated packaging

Dispose of as unused product.

14. TRANSPORT INFORMATION
ADR/RID

Not dangerous goods

IMDG

Not dangerous goods

IATA

Not dangerous goods

15. REGULATORY INFORMATION

Labelling according to EC Directives

Further information: The product does not need
to be labelled in accordance with EC directives or
respective national laws.
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Please help us speed up your service by

. properly cleaning your SAMI before return.
Cleanlng your SAMI SAMIs that are returned with excessive

f()r return tO SunburSt biofouling may be subject to additional

cleaning charges.
Sensors 1. Gently remove biological material from
- the surface of the SAMI. Do not use

i, . .
abrasive pads or metal scrapers as these

may damage the housing.

2. If there is significant fouling inside the
brass cage areas of the instrument,
remove the cage and spray a moderate
stream of water to remove what will
easily come off. Be careful of the fiber
optics and tubing. The brass cage can
be discarded.

3. After completing the above steps,
please allow 24 to 48 hours in a dry
area before packing up the instrument.
Never wrap a wet SAMI in plastic and
return to Sunburst.

To make cleaning easier, 10 mil PVC
corrosion protection tape can be applied to
the SAMI pre-deployment and then removed
along with fouling at the end of deployment.
This is available from many suppliers such
as McMaster Carr:
http://www.mcmaster.com/#7621A411
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